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Informacion General

DBDesigner 4 es un sistema de disefio de bases de datos disponible gratuita y libremente que integra disefio,
modelado, creacién y mantenimiento de bases de datos en un ambiente de desarrollo Gnico y compacto.

Esta escrito para Microsoft© Windows 2k/XP© y Linux KDE/Gnome para poderse utilizar en ambas
plataformas, Windows y Linux.
DBDesigner 4 se desarrolla y estd optimizado para MySQL -Database.

Licencia

DBDesigner para descarga gratuita y esta publicado bajo la Licencia GNU GPL.
Pulsa aqui para leer la Licencia GNU GPL.

Ayuda
Esta disponible ayuda gratuita durante la fase beta de test. Por favor navega a fabforce.net.
Envio de errores

Si has encontrado un error o tienes una idea de nuevas funcionalidades o caracteristicas por favor
visita fabforce.net.
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Fundamentos

La clave del uso de DBDesigner 4 es entender los fundamentos de bases de datos.
Lee los temas resumidos debajo - estas son las caracteristicas, técnicas y flujos de trabajo que son
fundamentales para trabajar con DBDesigner 4.

Modelos y Bases de Datos

En DBDesigner 4, siempre trabajas en un modelo. Un modelo es una visualizacion de la meta-informacion
almacenada en una base de datos (e.g. Tablas e Indices, Relaciones, ...) Aunque es posible guardar datos
iniciales en las tablas directamente en el modelo, sélo se representa la meta-informacion, no los datos en si
mismos.

Puedes crear y mantener tantos modelos como necesites, conteniendo un namero ilimitado de objetos. Un
objeto puede ser una tabla de base de datos con columnas e indices, una relacion entre dos tablas, una nota, ...

Los modelos pueden ser disefiador colocando estos objetos en el lienzo de modelo o pueden ser extraidos de
una base de datos existente usando la funcién de ingenieria inversa.

Para crear la base de datos el modelo puede ser exportado como un Script SQL de Creates o ser creado
directamente desde DBDesigner 4 usando la funcién de sincronizacién. La funcién de sincronizacién también
se usa para modificar la base de datos automaticamente cuando cambia el modelo.

Cuando DBDesigner cambia al Modo Consulta el modelo puede ser usado para construir complejas consultas
SQL y editar los datos de las tablas.

Los modelos se guardan como fichero XML o pueden ser almacenados directamente en la base de datos
activando el acceso distribuido al modelo.

El Interfaz de Usuario

El inferfaz de usuario se basa en estandares de software de disefio. Esto hace que crear tus modelos de base de
datos sea muy sencillo.
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GUI de DBDesigner
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A parte de los familiares menus de ventana, barras de desplazamiento y barras de estado DBDesigner 4 provee
varias paletas (ventanas flotantes) que pueden ser usadas para acceder a funciones mas rapidamente.

DBDesigner 4 hace extenso uso de funciones de ventana estandar como menus popup a los que se accede con
el botdn derecho del raton. Proveen funciones sensibles al contexto para los objetos. Arrastrar y Soltar se usa
para asignar tipos de datos a las columnas de las tablas o para construir indices.

producto

% idproducto: INTEGER. |

& ean Yarchar (200

@ info: TEXT [}
% img: LONGBLOE 5%
3 proguct_name
@ nornbre Fo
@ info

A proguct_ear =
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Seleccionar Objeta
Editar Objeto

Editar datoz de la Tabla
Actualizar Objeto

Eliminar Objeta

Alinear

Copiar nombre de la Tabla

Copiar todos loz nombres de campo

Copiar el nombre del campo seleccianado
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DBDesigner 4 tiene soporte para el Interfaz de Multiples Documentos (MDI) que te permite abrir un nimero
ilimitado de modelos al mismo tiempo. Puedes moverte entre modelos y usar comandos estandard de copiar y
pegar para intercambiar objetos entre los modelos.

Modelado

El modelo de base de datos se crea colocando diversos objetos en el lienzo, especificando sus atributos y
relaciones.

Para colocar un objeto has de seleccionar la herramienta adecuada de la Barra de Herramientas. Ademas de los
objetos méas importantes como Tablas y Relaciones (1:1, 1:1 generalizacion, 1:n, 1:n no identificadora, n:m)
puedes usar Notas, Imagenes y Regiones para ayudar a "entender” la estructura del modelo.

Docente: Ing. CIP Victor Ancajima Mifian Pagina 8 de 71



Modelamiento de Bases de Datos con Software Libre DbDesigner v. 4.0.5.6

fabFORCE =—tmasenesy

DB Designer4

OrlineStare
producto [v This table stores all the products,
% idproducto: INTEGER _1‘
& nombre: YWarchar(45) Mota

& ean: Warchar(Z0)
& precio: FLOAT(10,2)

Rel_01
T -—— 1:n Felacidn
Tabla
otlinecrderbasp
] @ idenlinenrdsr
Los Objetos

Tablas

Las Tablas representan tablas de bases de datos. La Tabla se muestra de forma similar a una ventana. El
nombre de la Tabla se indica en el titulo, las columnas se muestran debajo y estan indicadas con un icono. Un
icono en forma de llave indica que la tabla es una clave primaria.

Clave Primaria

Normalmente una 0 mas columnas estan definidas como la Clave Primaria (PK) de la tabla. Estas columnas no
pueden contener dos o mas valores iguales. Esto hace posible identificar claramente cada registro en la tabla
mediante la Clave Primaria (e.g. idproducto)

indices

Para hacer la base de datos encontrar un registro especifico mas rapidamente, es posible definir en un indice en
una 0 méas columnas. Los indices también se emplean para mejorar la velocidad cuando se realiza un JOIN
entre una 0 mas tablas.

Relaciones

Las relaciones pueden realizarse Unicamente entre dos tablas. Definen la relacion entre tablas y pueden crear
referencias de Claves Foraneas. Las tablas pueden conectarse con relaciones uno-a-uno (e.g. persona-
direccidn), uno-a-muchos (grupodeproducto - producto) o muchos-a-muchos (e.g. empleado - reunion).

Notas

Las notas son simplemente cajas de texto que contienen informacion acerca de una tabla o estructura. Pueden
colocarse en cualquier lugar en el modelo para proveer la informacion que se necesite.
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Iméagenes

Las imagenes pueden colocarse en el modelo para visualizar informacion adicional.

Regiones

Las regiones proveen espacio para tablas con los mismos atributos. Los atributos se asignan a la regién y se

aplican automaticamente a todas las tablas de esa region. Ademas pueden ser usadas por los plugins para
aplicar funciones especificas a un grupo de tablas.
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Modelado

Antes de empezar a modelar la base de datos el Modo Disefio debe seleccionarse. Para cambiar el Modo de
Trabajo actual pulsa el icono de Modo de Trabajo en la Paleta de Herramientas.

Tablas y Relaciones

Las tablas y relaciones son los componentes basicos para cualquier modelo de base de datos. Las tablas
consisten de un nombre de tabla, las columnas e indices y varias opciones de tabla. Las relaciones conectan
diferentes tablas unas con otras para formar relaciones uno-a-uno o uno-a-muchos.

Colocar una nueva tabla

Para colocar una nueva tabla en el modelo selecciona la Herramienta de Tabla de la Barra de Herramientas o

pulsa [T] en el teclado.
El cursor del ratén cambiara para reflejar la herramienta seleccionada actualmente.

B

-
i
&7

AR

Seleccionando la Herramienta de Tabla

Para colocar la tabla en el modelo pulsa el botdn izquierdo. Se creara una nueva tabla. Se llamara [table_XX].
La esquina superior izquierda estara en la posicion donde se pulso con el raton.

Después de que la tabla se coloque la herramienta seleccionada cambiara de nuevo a la Herramienta Puntero.
El cursor también cambiara.

Editar una tabla

Para editar una tabla existente asegUrate que la Herramienta Puntero esta seleccionada. Haz una doble
pulsacién en la tabla con el botdn izquierdo del raton. Se mostrara el Editor de Tablas.
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Llamando al editor de tablas

Definiendo nombres y columnas de tablas

Entra el nombre de la tabla (p.e. producto) y pulsa la tecla enter. El foco cambiara a la primera columna. Se
Ilamaréa id+nombre_de_tabla por defecto. Para aceptar este nombre pulsa enter o sobrescribelo antes de pulsar
enter.

Ahora el foco ha cambiado a la segunda columna. De nuevo entra el nombre de la columna y repite para todas
las columnas de la tabla.

Pulsa la tecla Esc después de asignar nombre a la Gltima columna.
Las columnas pueden ordenarse arrastrando y soltando. Pulsa con el boton izquierdo en el nombre de la

columna, mantén el boton pulsado y arrastrarla sobre otra columna. Suelta el boton del ratén y la columna se
insertara delante de la columna sobre la que se arrastro.

Asignando tipos de datos de las columnas
Pulsa la tecla Esc después de asignar nombre a la Gltima columna.
Asignando tipos de datos

Todas las columnas se crearan con el tipo por defecto (usa Opciones > Opciones de Modelo para cambiar el
tipo de datos por defecto).
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Para cambiar el tipo de datos de una columna ves a | a Paleta de Tipos de Datos y arrastra el tipo apropiado en
la columna en el Editor de Tablas. Si el tipo asignado tiene parametros (p.e. VARCHAR(xxx)) entra el valor
deseado. Pulsa enter para aplicar los cambios o Esc para descartarlos. Repitelo para todas las columnas de la

tabla.

Para cambiar el pardmetro de un tipo haz una doble pulsacion en el tipo de datos y entra el nuevo valor.

Clave Primaria, Autolnc y Opciones

La primera columna se define automaticamente como clave primaria de la tabla indicada con un Icono de
Llave a la izquierda del nombre de columna. Para eliminar una columna de la clave primaria pulsa el Icono de

Asignando tipos de datos

4 Ve
B it

Mambre Columna I Tipo de Datoz INNI Al I Flags
¥ idproducts | INTEGER o WU
& nombre 'Ab""-.r"archar[EE] i] [ 1Bl
@ ean i Varchar(20) _|Bl
@ precio T, FLOAT(10.2) Wk

Ksignando los par

ametros del tipo de datos

la Llave. Para afiadir una columna a la clave primaria pulsa en el Icono de Columna.
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Asignando la propiedad de Auto Incremento

Para hacer una columna autoincrementable tras la insercion pulsa la columna Al de su fila.

Cada tipo de datos tiene opciones especificas. Pueden activarse y desactivarse pulsandolas.

Valores por defecto y Comentarios

Para asignar un valor por defecto a una columna haz una doble pulsacion en la columna Valor por Defecto y
entra el valor. Pulsa enter para aplicar los cambios.

lIIFIags IDefauIt"v"alue Fr!
¢ |w|UNSIGHED | |ZEROFILL I}

[_|BIMNARY

|| UNSIGMED | _|ZEROFILL 0000000000

[w]UMSIGMED | _|ZERDFILL

[w]UMSIGMED | |ZERDFILL

[«] UMSIGMED | _|ZERDFILL

Asignando Valores por Defecto

Para mostrar los Comentarios de la columna pulsa el icono a la derecha del titulo de la columna Valor por

Defecto. Para editar un comentario haz una doble pulsacion en la columna Comentarios.

I Comments g
IFILL  The Autolncrement |

JFILL |
Containz the nm

Thiz iz the european

The product price in

Editar los comentarios de columna
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Crear Indices de Tabla

Cambia a la pestaia de Indices y pulsa el Icono Mas para afiadir un nuevo indice. Aparecera un dialogo de

Introduccion de Cadenas. Entra el nombre del indice y pulsa enter. Se mostrara el nuevo indice. Selecciona el
tipo de indice.

[ Indices = ]

[ndex

FPRIMARY T_h
Mz

<7 [ndex T,
Crear un nuevo indice de tabla

Para afiadir una columna al indice empieza arrastrando la columna hacia abajo a la Lista de Columnas y

suéltala. Puedes reordenar las columnas arrastrando las columnas. Para eliminar una columna pulsa el bot6n
Eliminar.

™ Table Editar =0
T sl By  TatiePriw Tabie Ty win gwiey
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W
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Anadir columnas al indice

Hacer una relaciéon

Afade otra tabla al modelo usando la Herramienta de Tabla (p.e. grupoproducto) y define las columnas de la
tabla. Ahora selecciona la Herramienta Relacion 1:n (Relacion No Identificadora) de la Barra de Herramientas.
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Seleccionar la Herramienta de Seleccion 1:n (Relacién No identificadora)

Para establecer la relacion pulsa en la primera tabla (grupoproducto) y luego en la segunda tabla (producto).
Ten en cuenta que la segunda tabla (producto) ahora tiene una clave foranea identificada por (FK) en la parte
derecha del tipo de dato.

product _ﬂ Rel 01 productgroup _ﬂ
% idproduct: INTEGER ¥ idproductaroup: IMTEGER
@ idproductgroup: INTEGER (FK) @ groupnarme: Yarchar(45)
& name: YWARCHAR(45) el

<

ear: Yarchar(20)
price: FLOAT(10,2]
info: TEXT

pic: LOMGELOB

3 proclct namis

& name

@ info

LEgE SR &

Tablas conectadas por una relacion

Haz una doble pulsacion en la relacion para entrar el nombre de la relacion. Cierra el Editor de Relaciones
para aplicar los cambios al modelo.
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Tablas conectadas por una relacion
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Consultando

Antes de empezar a hacer consultas en la base de datos debe seleccionarse el Modo Consulta. Para cambiar el
Modo de Trabajo actual debe pulsarse sobre el icono de Modo de Trabajo en la Barra de Herramientas o en la
Paleta de Herramientas o seleccionar Modo Consulta en el Menu Principal Mostrar.

Construyendo Selects

Se pueden construir Selects SQL facilmente mediante comandos de arrastrar y soltar. Asegurate que la
Herramienta Puntero esta seleccionada.

Un Select SQL sencillo

Para construir un select SQL para una tabla simplemente pulsa la tabla con el boton izquierdo del ratéon y
mantenlo pulsado. Ahora mueve el cursor hacia abajo. Se muestra el menu de arrastre.

Esta tabla guarda la informs:

producto j

% idproducto; INTEGER
& nombre: Yarchar(45)
& ean: Yarchar(20)

& precio: FLOAT(10,2)
& info TEXT

@ img: LOMNGBLOB

The Drag Menu

Mantén pulsado el botdn izquierdo del ratén y mueve el cursor sobre el boton SELECT. Suelta el botdon. Se
construira el comando SELECT y se motrara en el Editor de Comandos SQL.

Si la tabla de la que se va ha realizar la consulta no esta visible en la area visible del modelo, pulsa en
algunlugar en el modelo para asignar el foco al modelo. Ahora pulsa la tecla [Espacio] y arrastra el modelo
hasta que la tabla sea visible.

Realizando JOINs
Para unir (JOIN) otra tabla con esta pulsa en la tabla para realizar el JOIN. Empieza arrastrando igual que

antes y antes de soltar el botdn del raton muévete sobre el botén JOIN Table(s). Se creara un JOIN de las dos
tablas basado en las relaciones entre ellas.
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SELECT *
FROM product p, onlineorderhasproduct o
WHERE p.idproduct=o.idproduct

Dos tablas unidas (JOIN)

Otra posibilidad es seleccionar todas las tablas con las queremos hacer el JOIN manteniendo pulsada la tecla
Ctrl y pulsando sobre las tablas. Entonces empezar a arrastrar y seleccionar el boton JOIN Table(s).
Se creara un JOIN con todas las tablas basado en las relacones entre ellas.

Afnadir tablas sin hacer join

Para afiadir una o0 mas tablas a la consulta sin realizar un JOIN arrastra y selecciona el boton Add Table(s). Se
afiadiran al comando SQL.

Seleccionando columnas

Cuando un comando SQL se construye usando el MenU de Arrastre todas las columnas de la tabla(s) se
seleccionan usando la clausula SELECT *.

Para seleccionar columnas especificas de una tabla elije la Herramienta de Clausula SELECT de la Barra de
Herramientas o pulsa Ctrl+S. El cursor del raton cambiara al cursor Clausula SELECT. Ahora mueve el cursor
sobre la tabla y mira como se realzan las columnas. Mueve el cursor a la columna que deseas seleccionar y
pulsa con el botén izquierdo.

product A Thist
# idproduct: INTEGER

@ name: Yarchar(45)

& ean: Warchar(20)

& price: FLOAT(10,2)

_ proclaetnamis Pre
& name
G B2an

A proguct earn
& 2an

Seleccionando la columna de una Tabla
La columna se anadira al comando SELECT.
Anadir columnas a otras clausulas

Usa las diferentes Herramientas de Clausula de la Barra de Herramientas para afiadir columnas al comando
SQL.

Herramienta Tecla Posicion
SELECT Clause Tool Ctrl +S SELECT [column] FROM ...
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FROM Clause Tool  Ctrl+F SELECT * FROM table_a LEFT OUTER JOIN table_b ON [column] ...
WHERE Clause Tool Ctrl + W SELECT * FROM table_a WHERE [column] ...

GROUP Clause Tool Ctrl+ G SELECT * FROM table_a GROUP BY [column] ...

HAVING Clause Tool Ctrl+ H SELECT * FROM table_a GROUP BY coll HAVING [column] ...
ORDER Clause Tool Ctrl + O SELECT * FROM table_a ORDER BY [column] ...

SET Clause Tool Ctrl + E UPDATE table_a SET [column] ...

Pointer Tool Ctrl+Q -
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Interfaz de Usuario
Elementos Principales
El Menu Principal

A través del menu principal puedes acceder a las funciones generales del programa. Hay siete items en el
menu principal, Fichero, Editar, Base de Datos, Plugins, Opciones, Ventanas y Ayuda.

Menu Archivo

h] DBDesigner 4 - [Modelo BD | Monamez2]

E Fichero Editar Mostrar Ease de Datoz Pluging Opciones  Yentanas  Awuda
[} Huewvo

Abrir ...

Abrir de la Baze de Datos ..

Abrr Reciente k

Afadir/Enlazar Maodela 3

Guardar

Fuardar como ...

Guardar en la Base de Datos ...

Cerrar
Cerrar Todo
Esportar Crear Script SOL ...
Importar ¥ Seipt de eliminacion SAL ...
Configuracion de Fagina & Impresara .. Script de Optimizacién de Tabla SOL ...
[rprirnir ... SEL Bepair Table Script
Salir Expartar Modelo como Imagen ..
Exportar Dbjectos seleccionados como Imager,...
Expoart Model az MDE =ML File ...
The File Menu

Archivo - Nuevo

Archivo - Nuevo crea un nuevo modelo vacio. Si has abierto otro modelo antes puedes cambiar entre modelos
usando el menu Ventanas.

Archivo - Abrir ...

Archivo-Abrir ... abre un modelo existente del disco duro o de una unidad de red. DBDesigner crea un nuevo
modelo vacio cada vez que se inicia para que puedas empezar a trabajar inmediatamente. Si abres un modelo y
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no se han realizado cambios al modelo vacio se cerrard automaticamente y sera reemplazado por el modelo
abierto.

Archivo - Abrir desde Base de Datos ...

Archivo - Abrir desde Base de Datos... hace posible abrir un modelo guardado en una base de datos. When
selected this menu item the DB-Connection Dialog pops up and you have to select the database containing the
desired model. There can be stored more than one model in the database so you have to select the appropriate
model then.

Archivo - Open recent

Archivo - Open recent displays a list of the last opened models to improve speed opening the most used
models. If a new model is opened it is added to the list. If there are more than 10 entries in the list the last
entry is deleted automatically.

Archivo - Add Model ...

Archivo - Add Model ... lets you add an existing model to the currently opened model. After the model has
been imported all new objects are selected so the can be moved to an appropriate position.

Archivo - Save

Use Archivo-Archivo-Save ... to save your model to the harddisk or a mapped network device. When you save
a model for the first time, you are promt to locate the destination folder and enter the name of the model. The
model is added to the Archivo-Open Recent list automatically.

Archivo - Save As ...

Archivo - Save As ... can be used to save your current model with a new name. You are promt to locate the
destination folder and enter the new name of the model.

Archivo - Save in Database ...

It is possible to store the model directly in the database you work on. A new database table is used to store all
models in this database. This new table does not interfere with the database synconisation and reverse
engineering functions.

When selected the Archivo-Save in Database ... menu item the DB-Connection Dialog pops up and you have
to select the database which will containing the model. You have to enter the desired name of the model and
the model will be stored.

Archivo - Close

Archivo - Close closes the current active model.

Archivo - Export-SQL Create Script ...
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Use this menu item to export the current active model as a SQL Create script which can be executed against
the datbase manually to create the nessesary tables. You can use the database synchronise function instead
which will create and update your database automatically.

Archivo - Export-SQL Drop Script ...

Use this menu item to export the current active model as a SQL Drop script which can be executed against the
datbase manually to drop the desired tables. You can use the database synchronise function instead which will
create and update your database automatically.

Archivo - Export-Export Model as Image ...

Select this function to export the whole model as an image Archivo. The image can be saved in the PNG or
BMP file format. The PNG Format is recommended. Please note that using the BMP file format will result in
very large images, approximatly 20 MB at default size.

Archivo - Page & Printer Setup ...

Before printing the model you have to select the appropriate printer and set the page size and orientation as
well as the scale factor of the model which enables you to print the model distributed on several pages.

Archivo - Print ...
Archivo - Print ... lets you select the pages of the model an the number of copies you want to print.
Archivo - Exit

Archivo - Exit closes the program.

Editar Menu

IB Designer 4 - [DB Mod

= | Edit Display Database ¢
IUndao Edit Ohject
Redo

Copy selected
Cuk selected
Paste

Delete selected

Select Al

The Editar Menu
Editar - Undo

Use Editar - Undo to take back the last change applied to the model. You can use this command several times
to take back all changes you made.
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Editar - Redo

Editar - Redo applies the last undone action again. This command can also be repeated several times when you
have undone several actions.

Editar - Copy selected

When you have selected on or more objects you can use this command to copy the objects to the clipboard.
The objects are stored as text in XML format. You can use any other application to paste the objects.

Editar - Cut selected
This command is similar to Editar-Copy selected but the objects will also be deleted from the model.
Editar - Paste

Editar - Paste is used to insert previous copied objects from the clipboard. Relation are only inserted if both
tables have been copied because when the objects are inserted, new object-identifiers are assigned.

Editar - Delete selected

Editar - Delete selected removes all selected objects from the model. When this happens unintended you can
use the undo command.

Editar - Select All
Use Editar - Select All to select all objects from the model.

Mostrar Menu

esigner 4 - [DB Model | Moname 3]
it | Display Database Flugins Options Windows Help

v Design Mode
Query Mode
Matation L4
Table Columns

Table Indices »

Entity Level
Brimary key Level
v Display Relation Mames v Attribuke Level

Digplay Page Grid v Physical Schema Level

v Show Foreign Kews

The Mostrar Menu
Mostrar - Design Mode

Select this menu item to change to Design Mode. A checkmark will be drawn left to the menu item when
Design Mode is selected.
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Mostrar - Query Mode

Select this menu item to change to Query Mode. A checkmark will be drawn left to the menu item when Query
Mode is selected.

Mostrar - Notation

Mostrar - Notation specifies the notation used to display the model. When a notation is selected a checkmark
will be drawn left to the menu item.

Mostrar - Notation - EER

Mostrar - Notation - EER will set the notation to the common EER notation.

Mostrar - Notation - EER [1,n]

Mostrar - Notation - EER [1,n] will set the notation to another EER notation, displaying intervals.
Mostrar - Notation - Traditional

Mostrar - Notation - Traditional will change to a notation which will be familia to Erwin®© users.
Mostrar - Table Columns-Entity Level

Mostrar - Table Columns will specify how tables are displayed on the model. Use Mostrar - Table Columns-
Entity Level to hide all column information.

Mostrar - Table Columns-Primary Key Level

When Mostrar - Table Columns-Primary Key Level is selected, only primary key columns are displayed.
Mostrar - Table Columns-Attribute Level

Use Mostrar - Table Columns-Attribute Level to display all columns of the tables.

Mostrar - Table Columns-Physical Schema Level

Select Mostrar - Table Columns-Physical Schema Level to display the datatypes of the columns.
Mostrar - Table Columns-Show Foreign Keys

If Mostrar-Table Columns-Show Foreign Keys is select foreign keys are shown as columns in the appropriate
tables.

Mostrar - Table Indices
This menu item is used to display each table's indices on the model.

Mostrar - List Table Indices
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A checkmark will be drawn left to the menu item when table indices are displayed.
Mostrar - Mostrar Relation Names

Mostrar - Mostrar Relation Names can be selected to display the names of relations.
Mostrar - Mostrar Page Grid

Select Mostrar - Mostrar Page Grid to show the partitioning of printable pages. You can use the Page & Printer
Setup Dialog to change the initial page size.

Database Menu

"4 -[DB Model | Honame2]
¥ | Dakabase Plugins Opkions Window:

Diatabase Synchronisation

Reverse Engineering

The Database Menu

Database - Database Synchronisation

Use this function to synchronise your model with a database. This function can also be used with a clear
database to create all the tables.

Database - Reverse Engineering

Use this function to create a model based on an existing database.

Plugins Menu

Model | Noname2]
3se | Plugins ©pkions  Window
HTMLRepork

DakaImporter

The Plugins Menu

The Plugins Menu lists a number of DBDesigner 4 plugins available in the program's directory.
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Options Menu

fodel | arbeitszeit.xml]

e | Options Windows Help
Model Options

DB Designer Opkions

The Options Menu

Options - Model Options

Options - Model Options will call the Model Options Dialog where several options can be set for the model
like the default datatype or the display font.

Options - DBDesigner Options

Options - Model Options will call the Model DBDesigner Options Dialog where several general options can
be set.

Windows Menu

¢ | Windows Help
Cascade
Tile
Style Standard
v Toolbar Pokif
Tools Palette Sl
v Mavigator & Info Palette v Platinum

v Datakypes Paletke
v DB-Model Palette

Reset Palette Positions
Dock Palettes

v [onamez, xmil

The Windows Menu

Windows - Cascade

Use this command if you have opened several models and want to arrange the windows in a overlapping style.
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Windows - Tile

Use this command if you have opened several models and want to arrange the windows beside each other.
Windows - Style - Standard

The Windows-Style menu items can be used to change the overall appearance of the program.

Select Windows - Style - Standard to set the style to Windows default.

Windows - Style - Motif

Select Windows - Style - Motif to set the style to the Motif style.

Windows - Style - SGI

Select Windows - Style - Motif to set the style to the SGI style.

Windows - Style - Platinum

Select Windows - Style - Platinum to set the style to the Platinum style. This is the default window style.
Windows - Toolbar

Checked this menu item to display the Toolbar which is docked to the left of the main window.
Windows - Tools (MS Windows only)

If this menu item is checked the Tool-Palette becomes visible. It can be used instead of the Toolbar.
Windows - Navigator & Info Palette

If this menu item is checked the Navigator & Info-Palette becomes visible. If it is unchecked the Navigator &
Info-Palette is hidden.

Windows - Datatypes Palette

If this menu item is checked the Datatypes-Palette becomes visible. If it is unchecked the Datatypes - Palette is
hidden.

Windows - DB-Model Palette

If this menu item is checked the DB-Model-Palette becomes visible. If it is unchecked the DB-Model-Palette
is hidden.

Windows - Reset Palette Positions

Call this command to reset the palette positions to their initial locations.
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Windows - Dock Palettes
Use this menu item to dock or undock the palettes to the right of the main window.

Below this menu item a list of all opened models is displayed. Select a menu item to bring the appropriate
menu to the front.

Ayuda Menu

eit.xml]

1= | Help
Abouk

2nline Documentation

Wisit FabFORCE, com

Check For Mew Yersions

The Ayuda Menu

Ayuda - About

Displays the splash screen.

Ayuda - Online Documentation

Lauches an explorer with this documents.

Ayuda - Visit fabFORCE.net

Lauches an explorer and navigates to http://www.fabFORCE.net.

Ayuda - Check for New Versions
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Lauches an explorer, navigates to http://www.fabFORCE.net/downloads.
Palettes

Palettes are floating windows which always stay on top and provide fast access to important functions.

The Toolbar / Tools Palette

The Toolbar (and the Tools Palette) provides quick access to the most important work tools. (On a Linux
system the Tools Palette is disable because of a limitation in the window system.)

| pB Designer 4 - [DB Model | Moname 2]
IEﬁile Edit Display Database Plugins Options Windows Help

[} f—— Selection Tool ()

[ e Plowe Toul [
ki When switched to Query Mode:

S —— Seale Tool (E) [SELECT] ~#— Sdd Figld to SELECT Clause [Stge3]

P —— Dielete Tool LFRaH | ~e—— Add Field to FROM Clause [Strg+F)
[wHERE] ~e—— Add Field to WHERE Clausze [Strg+iw]

&M e—— PanTool(Space) [GFUF] -—— AddField to GROUF Clause [Stigs5)

\1\ —— Zoom Tool [ChrilsSpace f Clrls2ltsSpace) HEVIHG] ~-— Add Field to HAYIMG Clause [Strg«H)
ORDEFR] ~—— Add Field to ORDOER Clause [Strg+0)
] re—— Create new Region Toal S£T ] et—— Add Field to SET Clause [StrgeE)

[3y ~=+—— Create MNew Table Tool [T]
4| e—— Mew tn Non Identifying Fiel. Toal {ShiftsF) <J® | ==—— Switch ta Design Made
'|:.-I'{ ~—— Create Mew 1:n Relation Toal [R)

'|:.-I":|- ~—— Plew 11 Relation Tool [Crrl«F)

](_l‘f ~—— Pew 11 GeneralisationTool

}I{ —— Create Mew mem Relation Tool

Dg ~—— Create Mew Mobe Tool

d ~—— Place Mew Image Toaol

~—— DB-Syncronisation Function

r—— COutput SGIL Creates

;."J ——— Switch ba Query Mode

The Toolbar
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To view the Tools Palette select select [Windows]->[Tools] from the main menu. Deselect [Windows]-
>[Tools docked] to hide the docked palette. By default the Tools Palette can be found on the upper left corner
of the screen.

Selection Tool [G] —s [>+ +—— Poue Tool [W)]
Dielete Tool — o) t#—— Siale Tool(E)
Create new Region Tool ——st [ ™ Create hew Table Tool [T]

Rlew 1:n Blon dentifying Fel. Tool [ShifF)

?

Create Mew 1n Relation Tool [F] —-
Create Mew n:m Relation Tool —— w—— [Mlew 11 Relation Tool [(CrrlF)

Mew 11 Descendent Obj.Tool —e

B TIIE0 Qs

[ p B X
T

Create Mew Maote Tool ——t Flace Mew Image Tool

f’:’_"
=
e =

Fanning Tool [Space] — w—— Zoom Tool [Crrl«Space ! Crrl+Alt+Space)

Rewverse Engineering Function — w—— [BE-Syncronis ation Function

Cukput SGL Creates ——a | S0L Creates

Switch DesigniGuery Mode — | D

&
=
&

The Tools Palette

Click on the icon to activate the appropriate tool. The mouse cursor will change. Take a look at the Modelling
Section to see how to use the single tools.

Clicking on the buttons will call the assigned functions. Use the mode button to switch between the Design-

and Query-Mode. In Design-Mode tables can be moved with the selection tool, too. In Query-Mode you have
to use the Move-Tool.

The Navigator Palette

The Navigator Palette (top right) shows the current visible region of the model and can be used to navigate on
the model.
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|1

J I avigataor . Info

=] ':O:' (|
The Navigator Palette

Navigator Page

The current visible region is marked by a blue rectangle. When the model is scrolled or moved with the
panning tool the marker is moved to the new position automatically. Click on the white area to move the
marker and scroll the model to the appropriate position. Depending on the speed of your machine and the size
of the model you can also drag the marker.

To change to Zoom-Factor you can use the trackbar or click on the small and large table symbol left and right
to the trackbar. To enter the zoom factor manually click on the zoom edit, type in the desired value (without
percent charater) and press enter.

Click on the upper right icon to display the palette's popup menu. Select a menu item to set the zoom factor to
the displayed value.

Info Page
Click on the Info-Tab to switch to the info page. On this page you can change the name and position of the
selected object. When two or more objects are selected it is not possible to a value. When an image is selected

the size can also be changed.

The Datatypes Palette

The Datatypes-Palette (middle right) shows the existing datatypes which can be used to build the database-
tables.
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| Common 7 20l ypes @

- Mumeric Types

B ¢iDate and Time Types
ADATE
A DATETIME
A TIMESTAMP [len]
ATIME
AYEAR (len]
-é;String Types
w tBlob and Test Types
e Uszer defined Types

The Datatypes Palette

Common Datatypes Page

On the Common-Tab the most used Datatypes are visible and are ready to be dragged onto table columns. To
add a new User Defined Datatype click the upper right icon to display the palette's popup menu. Select Create
New Datatype and the Datatype-Dialog will be displayed showing the new created datatype. To remove a
Datatype from the Common-Tab select Del from Common Datatypes from the palette's popup menu.

All Datatypes-Page

Click on the All types-Tab to display all available datatypes. The datatypes are split into five categries.
Numeric Types, Date and Time Types, String Types, Blob and Text Types and User defined Types.
Doubleclick on a category to show all assigned datatypes. New created datatypes will always be assigned to
the User defined Types. Doubleclick on a datatype to call the Datatype Editor. Select and right click on a
datatype and select Add to Common Datatypes to add a Datatype to the Common-Tab.

Replace Datatypes in Tables

If you want to replace a datatype or change a parameter in several tables then you can use the Replace
Datatypes in Tables function from the palette's popup menu. It works just like the Search and Replace function
in Word®©.
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™ Replace Datatype
D atatype to Replace
| VARCHAR 4]
[ Match Params:  |[30]
Reqgion

Paramsz: |[45]

@' Replace in all Tables {:} Feplace only in selected T ables

*iﬁ; Erecute

The Replace Datatype Dialog

Select the datatype you want to replace. Then select the datatype which should be inserted. To change only the
parametes of a datatype select the same datatype in both dropdowns and check the Mach Params flag and enter

the parameter you want to replace and the parameter which should be inserted.

Select the Region of the function and press Execute to replace the datatype.

Reinitialise Datatypes

To reset the datatypes to their initial state select Reinitialise Datatypes from the palette's popup menu. The
inital settings will be loaded from the ini-files. Manually created datatypes will be replaced by the standard

datatype of the model.

The DB-Model-Palette

The DB-Model-Palette displays all existing tables in the model and their columns and relations.
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™/ DB Model _&&3
Al T ables T &P [

L% webuzer_duckzeit

" = webuzer_emailkonta

[ lager_artikel_hat_lisferant
" ) lager_artikel_sinheit

= lager_artikel_baugruppe

3 lager_artikel_medium
= ) lager_position
& Columns
- ¥ idlager_position
- idlager
- i@ position
B Relations
-3 Rel 50
-3 Rel 53
- 3 lager_hat_artikel
=]

£

B & lager

- &8 lager_artikel
E

£

- doc_hat_recht
- 3 recht_gruppe

The Model Palette

Click on the plus symbols to display the columns and relations of a table. Doubleclick on a table to call the
Table Editor or select Edit Object from the table's popup menu.

The Staturbar

The Statusbar displays information about the currently selected Tool an can be used to read and set the zoom
factor to a predefined value, fast.

B

2373
K%
4219 %

k.26 =

Madel has been changed indicator

Save to Oisk file
//, Save in Databaze

400 % Far I
755 | | €0 B =1 | Pointer [Q] [Click on a Table, Mote, ... to select the objer
The Statusbar
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Click on the Zoom Factor Edit left on the Statusbar. A list of zoom factors pops up. Select the desired zoom
factor or press ESC to close the list.

If the database model is modified the indicator left to the Zoom Factor Edit is painted red. Click on the Disc
Icon to save to model to disk. Click on the Database Icon to save the model in a Database.

Editors

Editors are used to specify and modify parameters of objects, datatypes, ...

An object's editor is usually called by doubleclicking on the object.

Table Editor
Call the Table Editor by doubleclicking on a table or selecting [Edit Object] from the table's popup menu. You

can also doubleclick the tables name in the DB-Model Palette or use the right mousebutton to call the popup
menu there.

How to use the Table Editor
To use the Table Editor the most efficient way use the following procedure.

I.) Create a new table in the model. Doubleclick on the table to call the Table Editor. The Table Name is
focused so enter the table name. Press [Return].

I1.) The focus will be set to the first line of the Table Columns. The first column will be named id+tablename
automatically. If the first column has to have a different name enter the column's name. Then press [Return].

I11.) Enter the next column name and press [Return]. Repeat this for all columns. Ignore the datatypes of the
columns at this time, all columns' datatypes are set to the default datatype initially.

IV.) After the last column has been entered, press [Esc] to abort the column edit mode.

V.) To assign the datatypes to the columns start by dragging the first column's datatype from the Datatype
palette onto the first column. Enter the datatype's parameters if the Parameter Editor pops up, e.g.
VARCHAR(__)

Repeat this for all column types.

VI1.) To define the primary key click on the columns' icon (left to the column name) to add or remove the
column from the primary key.

VII1.) Optionally define additional indices, the table options, the standard inserts and the table comments.
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"™ Table Editor MmEX]

Table Mame T able Frefix Table Type YWieak entity
| product | Default noprefis] | 4| | MYISAM [(Standard) $| [ isnmTable
Table Columns
Colurnn M ame IDataT_l,lpe INNI Al IFIags IDefauIt YValue [
% idproduct . INTEGER W o [W]UNSIGNED | |ZEROFILL
@ name Lk Warchar[45) || BINARY
& ean L Warchar20) |w] BINARY
@ price o FLOAT(0.2) [ |ZEROFILL
O
Indices = ]
Index
PRIMARY M ame: |F'H|M-"-"-HY Colurnrs: | idproduct i

product_name P
product_ean Index Type: [ PRIMARY =

The Table Editor

Table Settings
Table Name
Table Name displays the current name of the table. By pressing Return or leafing the edit field the Table Name

is checked against the reserved word list. If the Table Name equals a reserved word it is changed
automatically.

Table Prefix

In MySQL the Table Prefix can specify the database (db_name.tb1_name). Use this function if you want to
administrate several databases in only one model. The Table Prefixes are defined in the Model Options.

Table Type

MySQL supports several different Table Types. The most common types are MylSAM which is the default
type and InnoDB which supports transaction-safe tables with row locking.
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Weak entity

Check the [is n:m Table] checkbox if this table is a n:m Table.

Table Columns

The cursor keys can be used to move the Cursor between the Column Name, Datatype and the Default value
and the table columns. Press enter to change the focused value.

Use the mouse to dray an new datatype from the Datatype Palette onto the column. Doubleclick the datatype to
change the datatype's parameters.

Click on the Table Column's row to change the NOT NULL Flag, the Column Options and the Autoincrement
Flag.

Frimary Key lzon Column's Datatype Column Options Switch Def)al f Des.
T able Columnz *
[umn Mame | DataType INNI Al I Flags I Default Value P
¥ idproduct T INTEGER o W [#]UNSIGNED | |ZEROFILL
@ name i Yarchar(45) |_|EBINARY Mew Product
A L [ L TN £LOIkL s T *
-T Column Mame MOT RULL Column Default ¥ alue { Description
Calumn lzon Aukaincrement Column

The Table Columns

To enter a new column click on any column name an press the Page Down Key. The Cursor is placed below
the last column. Add the new column by entering the column name.

If you want to enter several new columns press return. The Curor is moved to the next row and the next
column name can be entered.

Drag the appropriate datatype from the Datatype Palette onto the new column. Enter the datatype's parameters
if needed.

Set the Column's NOT NULL Flag, the Column Options and the Autoincrement Flag if nessesary.
Table Indices

An unlimited number of indices can be defined for each table. The PRIMARY index is defined automatically
and cannot be deleted.
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Fage Selection

|
—l Indices | i]—

T - Bl Blew Indes
oF

- Delete Selected Index

product_name
product_ean

!

List of theTable's Indices

The Indices List

To add a new index click the plus button and enter the index name. Select the Index Type. You cannot select
the primary type manually because there can only be one primary index.

To delete an index select it in the index list and click the rubber button.

Index

M ame: I product_name Columns: | hame P

Index Type: [ INDE® |£l £4an
FRIMARY

LUMIGQUE INDEX
FULLTE=T INDEX

An Index

To add columns to the index drag the appropriate Table Columns down to the Index Columns listbox. You can
reorder the index's columns by drag'n'drop in the Index Columns listbox.

To delete a column from the index select the column in the Index Columns listbox and click the rubber button
to the right.

Standard Inserts
Every table can have it's Standard Inserts. They provide initial data for the tables.

When the SQL Creates are exported or the database is created by the syncronise function the Standard Inserts
can be exported or executed as well.
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—l Standard [nzerts i}

IMSERT IMTO product{idproduct, name, gan, price)
WALLUES(, 'Learning C++', "154 360423, 42.23);

IMSERT IMTD productiidproduct, name, ean, price)

The Standard Inserts

VaALUES(, 'Lord of the Rings - Part ', '437634323°, 23.18);

To add a SQL INSERT command click the right mouse button and select Paste SQL Insert from the Standard

Inserts memo's popup menu.

To clear the Standard Inserts click on the rubber button right to the Standard Inserts memao.

Table Options

The Table Options provide access to the MySQL specific table options. Please refere to the MySQL

documentation to understand the functionality of the several Table Options.

—[ Table Optionz i}

Mext Auto-lncrement Y alue; I 100

— Haow Settings

Average row length: I

Pazzword to encropt table: Itheprnducts'l 23

Delay key table updates [_] delay
] Pack Keys

binimum number of rows; I
b = number of raows: I

Rows farmat; || default

The Table Options

Advanced Table Options

Like the Table Options the Advanced Table Options provide access to the MySQL specific table options.
Please refere to the MySQL documentation to understand the functionality of the several Table Options.

—[ Advanced T able Options |i}

T able Drata directon: I

|ndey directony: I

RalD
[l Use Table R&ID RBAID Ty

MHumber of Chun
Chunbk.s

The Advanced Table Options
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Comments

To store additional information about the table select the Comments and enter the information.

Relation Editor

Comments =

Thiz table stares all the products.

Table Comments

The Relation Editor allows you to change the Kind of the relation, the Foreign Keys fields mapping and the

Relation Reference Definition.

E Relation Editor

-

[_] i Create Reference Definitiond

R elation Mame Relation Kind
| ProductRiel_01 | 1n $| [ Invisible
Fareign K.eps
Source Field Dest. Mame |E-:umment [ |
idproduct idproduct
[ Reference Definition = ]

Matching: | MATCH PARTIAL

On Delete: | CASCADE

On Update: | CASCADE

The Relation Editor
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Relation Name
Change this value to rename the relation.

Relation Kind

A relation can be one of the following kinds.

Kind Caption Explanation Example
1:1 one - to - one relation One row in the source table A relation between a [customer]
matches one row in the table and an [address] table. One
destination table. customer has one address.
1n one - to - many relation One row in the source table A relation between an [order]
matches many rows inthe  table and a [orderproduct] table.
destination table. One order can have many
products and a product in the
[orderproduct] table is only part
of one order.
1:n (Non one - to - many relation, One row in the source table A relation between a [payment]

Identifying) FK not in PK

matches many rows in the
destination table but the
Foreign Key in the
destination table is not in the
Primary Key Index.

table and an [order] table. Each
row in the [order] table as a
[payment] assigned to. Only
[idorder] is the Primary Key
field in the [order] table.

n:m many - to - many relation A n:m relation is always
broken down into two 1:n
relations.

1:1 one - to - one relation This relation is treated like a

(Generalisation)

Invisible

normal 1:1 relation within
DBDesigner 4. Some
plugins make use of this
type of relation.

Use this option to hide the relation. To make the relation visible again select the source table or the destination
table in the Model Palette, expand the relations and doubleclick the invisible relation. In the Relation Editor

disable this option.

Foreign Keys

Use the Foreign Key table to change the fieldnames of Foreign Keys in the destination table and to add

additional comments to the fields.
Doubleclick a value to change it.

Reference Definitions
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Select the Create Reference Definition checkbox to activate the Reference Definitions. Use the comboboxes to
select the appropriate actions for delete and update events.

Please note that native MySQL tables do not support Foreign Key Reference Definitions. Use InnoDB if
Foreign Key Reference Definitions are needed.

Optional Relation

To make the relation optional on one side check the appropriate option.
Comments

Use the Comments Memo to enter additional information about the relation.
Region Editor

Call the Region Editor from the region's popup menu. The Region Editor allows you to define default table
settings for all tables positioned on the region.

To activate set default settings selected the wanted options and enable the checkbox next to that option.

E Region Editor
Regionname Colar
Fregion_01) | Red ¢

Owerwrite T able Settingz

D atabaze: [ Default [ho prefiz) ¢] [ overwite
Table Type: [ M5 AM ¢] [ overwite
] Temporary Table ] overwite

Comments

The Region Editor

Regionname

Change this value to rename the region.
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Color

Each region is painted in an individual color. Choose from the list to specify the region's color.
Overwrite Table Settings

Select the appropriate settings and check the overwrite checkbox to activate them.

Comments

The comments memo can be used to store informations about the region.

Note Editor

Doubleclick on a new created note to enter call the Note Editor and enter the note's text.

H Hote Editor

Mote Text
[T his table storez all the products.

The Note Editor

Image Editor

Doubleclick on a image to call the Image Editor.

™ Image Editor
Imagename A
|||TIEEIE_D4 F:I_/ [ Enable Image streching
[ Restore Size l [ Restore Azpect Batio ] [ Clear Image

The Image Editor

Docente: Ing. CIP Victor Ancajima Mifian Pagina 44 de 71



Modelamiento de Bases de Datos con Software Libre DbDesigner v. 4.0.5.6

Load New Image

To replace this image with an updated version of the image or a different image click the Image Folder button.
A file browser is shown and you can select the image.

Currently only the PNG and BMP image formats are supported.

Strech Image

When the Strech Image option is selected you are able to resize the image.

Restore Size

To restore the original size of the image after it has be rescaled press the Restore Size button.
Restore Aspect Ratio

When the image has been resized and the aspect ratio was changed press the Restore Aspect Ration button to
change the height of the image according to the aspect ration.

Clear Image

Press the Clear Image button to remove the bitmap.

Datatype Editor

Doubleclick on a datatype in the Datatype Palette to call the Datatype Editor.

Query Editor

To call the Query Editor from Design Mode right-click on the table and select Edit Table Data from the popup
menu.

When DBDesigner 4 is Query Mode a docked Query Editor is shown at the bottom of the main window. To
open another editor double-click on the appropriate table.

If there is no active database connection the Database Connection Dialog will be shown. Create a new or select
an existing database connection and click connect.
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The Query Editor

The Query Editor can be divided into two main areas, the SQL Command Editor and the Data Grid.

The SQL Command Editor is used to specify a SQL Command. The Data Grid will display the result returned
from the Database.

The SQL Command Editor is extended by the SQL Command Storage Tree. The SQL Command Storage Tree
is used to store SQL commands permanently with the model and to keep a command history.

The Data Grid is extended by the BLOB Editor. BLOB Editor is used to modify, load and save data from or to
BLOB fields.

Viewing and hiding the areas.

When the Query Editor is opened from Design Mode or by double-clicking a table in Query Mode, only the
Data Grid is visible. To display the SQL Command Editor click the SQL button at the right.

To display the SQL Command Storage Tree click on the tree icon right to the SQL Command Editor.

To edit the content of a BLOB Field click on the BLOB button at the right.

Creacion y Mantenimiento de Bases de Datos

Exportacion SQL Tradicional

Como cualquier otra herramienta de modelado de bases de datos DBDesigner 4 puede exportar el modelo
como un script SQL que puede ser ejecutado en cualquier herramienta de mantenimiento de bases de datos,
como la linea de comandos de MySql.

Todos los comandos SQL CREATE TABLE vy los Insert Estdndar pueden exportarse como en cualquier otra
herramienta de modelado de bases de datos a un fichero de script SQL que puede ser ejecutado por cualquier
herramienta de mantenimiento de bases de datos, como por ejemplo la herramienta de linea de comandos de

MySQL.
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También es posible generar todos los comandos SQL DROP TABLE.

¢ Qué es la Sincronizacién de Bases de Datos?

Con DBDesigner 4 puedes simplificar la tarea de crear y mantener tu base de datos. DBDesigner 4 ofrece la
posibilidad de conectarte a un servidor MySQL y crear y sincronizar una base de datos con el modelo de
disefiado.

Con sincronizacion queremos decir que DBDesigner 4 busca todas las tablas en la base de datos existente y
comprueba las diferencias. Si la tabla existe en el modelo pero no en la base de datos,se ejecuta el comando
SQL CREATE TABLE necesario.

Si la tabla no existe en el modelo pero si en la base de datos puede ser borrada dependiendo de las opciones
del usuario.

Si la tabla existe en el modelo y en la base de datos también, se comparan todos los campos y si hay una
diferencia, se ejecuta el comando SQL ALTER TABLE apropiado.

¢, Qué es Ingenieria Inversa?

Realizar la ingenieria inversa en una base de datos significa conectarse al servidor de bases de datos, elegir una
base de datos existente y construir automaticamente un modelo basado en la meta informacion en la base de
datos.

En DBDesigner 4 toda la informacion de las tablas se extrae de la meta informacion y las relaciones entre
tablas se extraen de nombres de tablas y campos. Las tablas se colocan en el modelo en orden alfabético
siguiendo un esquema de cuadricula definido por el usuario.

El proceso de ingenieria inversa es posible en MySQL, Oracle y cualquier otra base de datos accesible
mediante ODBC.

La extraccion de toda la informacion de las tablas es solamente posible usando una base de datos MySQL. Las
demas bases de datos estan limitadas por las limitaciones del ODBC.

Exportar Creates SQL

Para exportar el script create SQL en tu modelo actual de base de datos selecciona Fichero-Exportar-Script
Create SQL ... Aparecerd el didlogo de Exportacion SQL.
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ExportSQLScript A

— Preferencias Generales

[ {Expartar sélo zelecoidn: W] Al Tables

L] Ordenar las tablas por FE,

— Preferencias de creacion SGL

[ Definir PE [ Opciones de Tabla
3 Crear indices 3 Gererar Inzertz Standard
L1 Defirir Beferencias de FE si estd activo en el Editor de Felaciones

] Generar Comentarios

LI:'I Copiar al Porta Papeles H Guardar en Fichero x

Dialogo de exportacion de Creates SQL

Para exportar los Creates SQL a un fichero, pulsa el botén [Guardar en Fichero]. Se preguntara el nombre del
fichero y el destino. Pulsa [Guardar] para escribir el script en el disco.

Cuando un shell SQL se abre, puede ser Util copiar el script al porta papeles y ejecutar directamente el shell
SQL. Para copiar el script SQL al porta papeles pulsa el boton [Copiar al Porta Papeles].

Opciones Create SQL
La salida puede ser personalizada usando las siguientes Opciones Generales y las Opciones de Create SQL.
Exportar solo tablas seleccionadas

Marca esta opcion para exportar solo las tablas seleccionadas. Las deméas demas tablas no seran creadas en el
fichero de script.

Ordenar Tablas por Clave Foranea

Usa esta opcidn para cambiar el orden de creacion. Por defecto las tablas se crean en orden alfabético. Cuando
usas las claves foraneas es necesario cambiar el orden en que se crean las tablas.

Las tablas sin relaciones que apunten a ellas han de ser creadas primero. Las demas tablas se crearan solo
cuando existan todas las tablas de origen.
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Si hay una coleccidn de relaciones ciclica, las tablas no pueden ser creadas. Se mostrara un mensaje de error.
AUn asi puedes exportar las tablas en orden alfabético.

Definir Claves Foraneas
Activa esta opcion si quieres activar la creacion de claves primarias.
Crear Indices

Activa esta opcion si quieres activar la creacion de indices. No incluye las claves primarias. Activa la opcion
Definir Claves Foraneas para crear claves primarias.

Definir Referencia de Claves Foraneas

Usa esta opcidn para habilitar las referencias en las claves foraneas en los comandos SQL CREATE TABLE.
Ten en cuenta que tendras que activar la opcion Ordenar Tablas por Claves Foraneas para hacer funcionar el
script SQL.

Opciones de Generacion de Tabla

Usa esta opcidn para habilitar las opciones de tabla en los comandos SQL CREATE TABLE. Es necesario
solo si has especificado las Opciones de las Tablas para la tabla en el modelo.

Generar Inserts Estandar

Usa esta opcidn para exportar los Insert Estandar en el script SQL de creacion. Es necesario solo si has
especificado Inserts Estandar para la tabla en el modelo.

Exportar Drops SQL

Para exportar un script Drop SQL basado en el modelo de base de datos actual selecciona Archivo-Exportar-
Script Drop SQL ... Aparece el didlogo de Exportacién de Scripts SQL
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Export SQL Script |
— Preferencias Generalez

[_] {Exportar sélo zelecoidn: W] Al Tables
[]SystemT ables

] Ordenar las tablas por FE, (] OnfineStare
[T Forum

L . .
L._LI Copiar al Porta Papeles H Guardar en Fichero x

Dialogo de Exportacion SQL de Drops

Para exportar los Drops SQL a un fichero, pulsa el botén [Guardar en Fichero]. Se preguntara el nombre del
fichero y el destino. Pulsa [Guardar] para escribir el script en el disco.

Cuando un shell SQL se abre, puede ser til copiar el script al porta papeles y ejecutar directamente el shell
SQL. Para copiar el script SQL al porta papeles pulsa el boton [Copiar al Porta Papeles].

Opciones del Drop SQL
La salida puede personalizarse usando las siguientes Opciones Generales y las Opciones de Drop SQL
Exportar solo tablas seleccionadas

Marca esta opcion para exportar solo las tablas seleccionadas. Las demas demas tablas no seran borradas en el
fichero de script Drop.

Ordenar Tablas por Clave Foranea

Usa esta opcidn para cambiar el orden de creacion. Por defecto las tablas se crean en orden alfabético. Cuando
usas las claves foraneas es necesario cambiar el orden en que se eliminan las tablas.
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Las tablas se borraran en orden inverso a como fueron creadas.
Si hay una coleccidn de relaciones ciclicas, las tablas no pueden ser borradas. Se mostrara un mensaje de error.
Ten en cuenta que aun asi puedes exportar las tablas en orden alfabético.

Conexiones a la Base de Datos

Varias funciones en DBDesigner 4 usan conexiones a Bases de Datos. Se usan para establecer una conexién a
una base de datos al seleccionar el servidor y base de datos apropiados.

Crear una nueva Conexion de Base de Datos

Una nueva Conexion de Base de Datos se crea en el Didlogo de Conexiones de Bases de Datos.

Para crea una nueva Conexion a Base de Datos, pulsa sobre el boton de Nueva Conexién a Base de Datos. Se
mostrara el Didlogo de Parametros de Conexion. Especifica toda la informacion necesaria y pulsa OK para
afiadir la conexidn a la lista de conexiones.

Conectar a una Base de Datos

Para conectar a una base de datos se usa el Didlogo de Conexion a Bases de Datos, igual que al crear una
nueva Conexion de Bases de Datos.

Selecciona la conexidn apropiada de la lista de conexiones. Entra un nombre de usuario y un password y pulsa
el botdn Conectar para establecer la conexién

A tener en cuenta

Para hacer cambios a la meta informacion en una base de datos es necesario conectar como un usuario con los
derechos correctos. En MySQL el administrador de base de datos se llama root. Tiene todos los privilegios y
puede crear una nueva base de datos o hacer cambios a cualquiera que ya exista. Los demas usuarios Los
demaés usuarios tienen permiso para modificar solamente las tablas para las que se le han especificado
privilegios.

Para evitar problemas mientras se realiza la sincronizacién o se consulta una base de datos asegurate que el
usuario que usas para conectarte tienes suficientes privilegios.

El Dialogo de Conexion a Bases de Datos
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Select Database Connection

Servidores de Fed

B 5 MyS0L

-- n:ﬁ! Localhost

=8 ity Metwork Hosts
-- %) localhost

Bl 5 SOLite

- ) Oracle

H- 1) M550L

B ODBC

=1 Mueva Conerion BD

Todas lag conexiones a BD

@] T odas las conexiones

AEOffice Oracle

WORLD.OFFICE

Connection I Tupe I Huost I Database I Description I |
b Dirupal MeSQL  127.0.01 drupal
b= Admin MySOL  localhost drupal Conexidn ala baze d.. ...

Conexian : I Office

I zLaariax I SYSTEM

| 4 Conectar I

Fazzword: IN x Anular

Dialogo de Conexion a Bases de Datos

El Dialogo de Conexion a Bases de Datos tiene tres areas, el Arbol de Servidores de Red, La Lista de
Conexiones y la seccién de Usuario/Password.

Arbol de Servidores de Red

El Arbol de Servidores de Red muestra todos los servidores y sus bases de datos. Se usa como filtro para
mostrar conexiones y para crear nuevas conexion a servidores de bases de datos.

Cuando el primer nodo, llamado [Todas las Conexiones] esta seleccionado, todas las conexiones introducidas
se mostraran en la Lista de Conexiones.

Para mostrar todas las conexiones al servidor local de MySQL selecciona [MySQL]-[Localhost]

Para mostrar todas las conexiones a servidores MySQL en la red selecciona [MySQL]-[Network Hosts]

Para mostrar todas las conexiones a un servidor MySQL especifico de una red selecciona el nombre del
servidor en el nodo [MySQL]-[Network Hosts]

Las conexiones a Oracle o ODBC pueden filtrarse de la misma manera.

Mostrar bases de Datos del Servidor

Para mostrar las bases de datos de un servidor dado pulsa en el icono [+] a la izquierda del nombre del
servidor. DBDesigner 4 preguntara por el nombre de usuario y password que se utilizaran para validarse. Ten
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en cuenta que el usuario especificado debe tener los permisos adecuados para ejecutar un comando SQL
SHOW DATABASES.

Entrar un nuevo Servidor

Después de la instalacion de DBDesigner 4 es posible conectar Gnicamente al servidor local de MySQL. Para
afiadir un nuevo servidor de red haz lo siguiente.

Para entrar un nuevo servidor, pulsa en [...] nodo listado bajo el [Network Hosts] en el nodo del tipo de base de
datos deseado. Se mostraréa el didlogo de Afadir nuevo Host.

Anadir nuevo Hosk |

Marmbre Host: IDF|E|N-"-"- v R

Diélogo de Afadir nuevo Servidor

Entrar el nombre del nodo seguido por una barra y su direccién IP. En lugar de la direccion IP el nombre de
red del servidor puede especificarse, p.e. webserver o www.theserver.com.

Pulsa enter para crear en nuevo servidor en el Arbol de Servidores de Red
Cambiar los parametros del Servidor

Para cambiar el nombre o la direccién IP de un servidor pulsa con el botdn derecho en un Servidor. Se
mostrara el mend popup de servidores.
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Select Database Connection

Servidores de Red Todaz las
i Todas las conexiones Connectis
=8 o MysaL 4»Drupal
-- g8 Localhost A dmin
=- ity Metwark Hosts i Office
.. i.._tl
o = Renombrar host
B- ) S0Lite Cambiar IF del host
- [ Oracle Elirninar Hast
(- MSSUL Eliminar BD
Bl (= ODBC ;
Cone
%  Mueva Conexién BD | 4 I Us

Menu popup de servidores

Selecciona la funcion que quieras del mend.

Eliminar un Servidor

Para eliminar un Servidor selecciona [Eliminar Host] del menu popup.

Crear una nueva base de datos

Es posible crear una nueva base de datos desde el Didlogo de Conexion a Base de Datos. Para crear una nueva
base de datos muestra todos los servidores de bases de datos como ya se ha explicado. Pulsa el tltimo nodo
bajo el nodo del Servidor que tiene el texto [...]. Aparecera el Diadlogo de Nueva Base de Datos. Introduce el
nombre de la base de datos y pulsa enter. Se creara la base de datos.

Eliminar base de datos

Es posible eliminar una base de datos desde el Didlogo de Conexion a Base de Datos. Para eliminar una base

de datos muestra los servidores de bases de datos como ya se ha explicado. Pulsa sobre el nodo de base de
datos con el botdn derecho para mostrar el mend popup. Selecciona [Eliminar Base de Datos].

Ten en cuenta que una vez la base de datos ha sido eliminada no puede ser restaurada. Para recuperarla
necesitaras una copia de seguridad.

Lista de Conexiones

La Lista de Conexiones muestra las conexiones seleccionadas en el Arbol de Servidores de Red. Pulsa en la
conexion deseada para poner la conexién en la Seccién de Usuario.

Creando una nueva conexioén
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Para crear una nueva conexion selecciona el Servidor la que conectar del Arbol de Servidores de Red.
Visualiza los Servidores de base de datos. Ahora arrastra la base de datos a la que quieres conectar en la Lista
de Conexiones. Se creara una nueva conexion.

En lugar de arrastrar la base de datos puedes seleccionar la base de datos con el botdn izquierdo y pulsar el
boton [Nueva Conexion a la Base de Datos seleccionadal].

La lista de columnas

La lista tiene seis columnas. EI nombre de la conexion muestra el nombre de la conexion. Haz una doble
pulsacién para cambiarlo.

Tipo muestra el tipo de base de datos a la que se refiere la conexion. Haz una doble pulsacion sobre el tipo

para cambiarlo.

Pulsa en el botdn [...] para mostrar los pardmetros de conexion.

La seccidon de Usuario

Cuando se selecciona una conexién a base de datos en la Lista de Conexiones se muestra el nombre de la
conexion en la Seccion de Usuario y DBDesigner 4 pregunta por el password de usuario. El password nunca se
guarda en la conexion de base de datos por motivos de seguridad.

Pulsa return o el botdn [Connect] para establecer la conexion con la base de datos. Si se realiza correctamente
la conexion el dialogo de cierra. Si ocurre un error, p.e. ep password es erroneo, se muestra el error

Dialogo de Parametros de Conexién

El Didlogo de Pardmetros de Conexion se usa para cambiar la conexion.
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Database Connection Editor |

General |.-'1'-.vanzad|:||

Maormbre de conexidn: IDrupal Driver: | MpSOL ¥

— Pardmetros de Conexidn

Hast IP: [ localhost i] Fusrta: Iﬁ

Mombre de BD: Idrupal

Izuario: I ronk Passward: |75

Descrpcidn: | Conexidn a la baze de datos Drupal en el localhost

o Anular | | &« 0K

Diélogo de Parametros de Conexion

Nombre de la Conexion

Cada Conexion de Base de Datos esta definido por un nombre Unico.

IP de Host

Entra la direccion IP del servidor o su nombre de red. Es sélo necesario para conexiones con MySQL.
Nombre de la base de datos

Entra el nombre de la base de datos. Cuando uses el Driver de MySQL este es el nombre que se usara en el
comando CREATE DATABASE SQL.

Cuando esta seleccionado el Driver ODBC entra el Nombre de Origen de Datos ODBC (DNS).
Cuando uses el Driver Oracle entra el nombre de la conexion
Driver

Selecciona un driver de base de datos de la lista desplegable. Cuando se selecciona un nuevo driver todos los
valores se restablecen a su valor inicial.

Docente: Ing. CIP Victor Ancajima Mifian Pagina 56 de 71



Modelamiento de Bases de Datos con Software Libre DbDesigner v. 4.0.5.6

Nombre de Usuario

Especifica el nombre de usuario usado para conectar a la base de datos.

Password

Especifica el password a usar para conectar a la base de datos.

Descripcion

Entra una descripcion con algo de informacion acerca de la conexion a la base de datos.

Pestafia Avanzado

Atencion. Modifica los parametros de conexion avanzada Unicamente si sabes 1o que estas haciendo. El boton
[Reiniciar por defecto] puede usarse para reiniciar los parametros de conexién a su valor por defecto. Para

afiadir o borrar un parametro usa los correspondientes botones.

Los parametros por defecto pueden modificarse editando el fichero DBDesigner4_DBDefaultSettings.ini en el
directorio de datos de DBDesigner 4.

La columna del servidor muestra la IP o el nombre del servidor entrado. Haz una doble pulsacion en la
IP/nombre de servidor para cambiarlo.

La columna base de datos muestra la conexion a base de datos. Haz una doble pulsacion para cambiar el valor.

La columna de descripcion muestra informacidn adicional acerca de la conexion. Puede cambiarse haciendo
una doble pulsacion.

Sincronizacién de la Base de Datos

Para sincronizar el modelo con una base de datos selecciona [Base de datos]->[Sincronizacion con la Base de
Datos] del menu principal. La sincronizacion también puede llamarse pulsando el boton [Sync] en la paleta de
Herramientas. Ten en cuenta que un modelo vacio no puede sincronizarse.

Se mostrara el Dialogo de Conexion a Base de Datos. Selecciona la conexion a la base de datos con la que se
va a hacer la sincronizacion. Entra el password de usuario y pulsa [Conectar] para establecer la conexion.

Sincronizar con una nueva base de datos

La funcion de sincronizacion puede ejecutarse contra una base de datos vacia. Todas las tablas se crearan y se
realizaran las inserciones de los Insert Estandar en las tablas.

Para sincronizar el modelo con la nueva base de datos llama al Sincronizador de Base de Datos. Se mostrara el
Diélogo de Conexion de Base de Datos. Para crear una nueva base de datos muestra los Servidores de bases de
datos y pulsa el nodo etiquetado como [...] tal y como se explica arriba. Pon nombre a la base de datos y crea
una nueva conexion arrastrando el nodo de la base de datos a la Lista de Conexiones. Ahora, conecta a la
nueva Base de Datos.
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Database Synchronisation H

Conexion de BD

IDrupaI T

— Opciones
& ‘plicar cambios ala BD: 3 Aplicar cambios al Models

W Mo eliminar Tablaz existentes.
M Ejecutar Inserts Standard al crear nuevas T ablas

] Sincronizar Inzerts Standard

— Progrezo

Conectado ala BD rootiEdrupal
B5 Tahle(z] in Databaze, 14 Tablelz] in Maodel.

L

*.} Ejecutar x Cerrar

=i Conectado 3 la BD root@drupal
Database Syncronisation

Opciones de Sincronizacion

Cuando se establezca la conexion a la base de datos de forma correcta se mostrara el Dialogo de
Sincronizacion con Bases de Datos.

Conexion a la Base de Datos

El nombre de la conexidn de la base de datos se mostrara en la parte de arriba. Para conectar a una base de
datos diferente pulsa el botdn derecho en el nombre de conexion. El Didlogo de Conexidn a la Base de Datos
se volverd a mostrar y podra seleccionarse una nueva conexion.

Aplicar cambios a la Base de Datos

Esta opcion esta seleccionada por defecto. La base de datos se modificara para reflejar los cambios hechos en
el modelo. EI modelo no se modificara al ejecutar la sincronizacion.

Aplicar cambios al Modelo
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Para modificar el modelo en lugar de la base de datos selecciona esta opcion. La base de datos no se
modificara al ejecutar la funcion de sincronizacion.

Esta funcidn sera activada en futuras versiones de DBDesigner 4. En estos momentos usa las funciones de
Ingenieria Inversa en su lugar.

No eliminar Tablas existentes

Selecciona esta opcion para mantener las tablas en la base de datos que no estan presentes en el modelo. Si
esta opcidn no esta seleccionada esas tablas seran borradas.

Ejecuta Inserts Estandar cuando se Crean Nuevas Tablas

Si se activa esta opcidn los Inserts Estandar se insertaran en el nuevo crear tabla. Esta opcion esta seleccionada
por defecto.

Sincronizar Inserts Estandar

Activa esta opcion cuando cuando se han hecho cambios a los Inserts Standard. Las filas se compararan
usando los campos de clave primaria. Si una fila en la base de datos coincide con una fila en los Inserts
Standard se compararan el resto de valores del Insert Standard. Los valores que no figuren en el Insert
Standard seré ignorado. Se realizaran los cambios apropiados a las filas a la base de datos.

Las filas de la base de datos con un valor en la clave primaria que no coinciden con ninguna clave primaria en
los Insert Standard se mantendran sin cambios. Por ello esas filas introducidas manualmente se quedaran en la

tabla aln cuando esta opcion (Sincronizar Inserts Standard) esté seleccionada. Si un Insert Standard se borra
en el modelo tendra que ser borrado de la fila de la tabla de la base de datos manualmente.

Ejecutando la sincronizacién

La sincronizacion no puede deshacerse. Antes de ejecutarla comprueba todas las opciones seleccionadas.
Verifica la Lista de Progreso que muestra la informacion de la conexion y el nimero de tablas en la base de
datos y el modelo. La informacion de la conexidn se mostrara [usuario@basededatos], p.e. [root@webshop].

Para ejecutar la sincronizacion pulsa el boton [Ejecutar] al final del didlogo.

La ejecucion puede vigilarse a través de la Lista de Progreso. Se listaran todas las comprobaciones y cambios.
Ingenieria Inversa

Para llamar la funcion de Ingenieria Inversa selecciona [Base de Datos]->[Ingenieria Inversa] desde menu
principal. La funcion también puede llamarse pulsando el botén [Rev.] en la Paleta de Herramientas.

Normalmente la funcion de Ingenieria Inversa se Ilamara con un modelo vacio. También es posible afiadir las
tablas a un modelo existente. Si las tablas deben crearse en un nuevo modelo seleciona [Archivo]->[Nuevo]
desde el mena principal antes de llamar la funcién.

El Didlogo de la Base de Datos se mostrara. Selecciona o crea una conexion a la base de datos sobre la que se
debe hacer la ingenieria inversa y establezca la conexion.
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Reverse Engineering ||| k|
Conexion BD
IDrupaI éﬁ
Tablaz Ezquema
W] access E [ All | i]
accesslog
aggregator_categarny Importante
aggregator_category_feed &l conectar con Oracle o M5 SOL
aggregator_categaory_ikem asegurate de tener privilegios, 5idudas
aggregator_feed conects como DBA: SYSTEM [Dracle] o 2a
aggregator_itern (k3 SO
authrnap
barirer
blocks |
— Opciones Generales —|af Substituir ipos de datos
[ Izar funciones especificas MySEL |i] [ kS GL Standard |i]
; int=INTEGER
I'IEI T ablaz colocadas en una linea dec=DECIMAL
L] Colapsa Tablas, para ahorar espacio u
] Importa el Ezguema coma Frefijos de Tabla ﬂ
] Put Default ¥alues in Duotes
—_] Relaciones —_1 Crear Inzertz Standard para datos —
Q' Bazadaz en Clave Primaria o M2de Fegistros i awimo: |2I:I

D Bazadaz en Maombres de Tabla y Campos

D Select [Wativoz para recuperar Belaciones

*3} E jeciuitar x Cemar

=g Conectado a la BLD roob@drupal

Dialogo de Ingenieria Inversa

Cuando la conexion a la base de datos se establece correctamente se muetra el Didlogo de Ingenieria Inversa.

Conexion a Base de Datos

El nombre de la conexidn a la base de datos se muestra en la parte superior. Para conectar a una base de datos
diferentes pula el botdn a la derecha del nombre de la conexién. Se mostrara de nuevo el Dialogo de Conexion
a la Base de Datos y podra seleccionarse una base de datos diferente.

Tablas
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Selecciona todas las tablas de la base de datos que deben ser creadas en el modelo. Todas las tablas estan
seleccionadas por defecto. Para seleccionar todas las tablas cuando algunas de ellas han sido deseleccionadas
pulsa el boton [Selecciona todas las Tablas]. Para deseleccionar todas las tablas pulsa el boton [Deseleccionar
todas las Tablas].

Cuando se selecciona una Base de Datos de MS Access las tablas del sistema de MS Access se deseleccionan
automaticamente.

Opciones Generales

Usa funciones especificas de MySQL

Selecciona esta opcion cuando realices la ingenieria inversa en una base de datos MySQL. Las funciones
especificas de MySQL como DESCRIBE TABLE se usaran para generar una copia mas exacta de la estructura
de la tabla. No usar esta opcidn con ninguna otra base de datos.

Usa funciones generales

Usa esta opcidn al realizar una ingenieria inversa de una base de datos que no sea MySQL.

NuUmero de tablas en una fila

Al hacer la ingenieria inversa en una base de datos todas las bases de datos seleccionadas se colocan en filas y
columnas en el lienzo de modelos. Esta opcion especifica en nimero de tablas en una fila.

Construir Relaciones

Usa esta opcion para permitir a DBDesigner 4 crear las relaciones entre las tablas de forma automatica. Debe
tenerse en cuenta que pueden cometerse errores. Asi que simpre se debe comprobar las relaciones después de
hacer la ingenieria inversa de la base de datos.

Crear Relaciones basadas en Claves Primarias

Selecciona esta opcidn para crear relaciones entre tablas del modelo de forma automatica. La relacion se creard
entre los campos de sus claves primarias. Cando los campos de claves primarias de una tabla estan presentes
en la otra se creara una relacion 1:n.

Crear Relaciones basadas en nombre de Tablas

Selecciona esta opcion para crear relaciones entre tablas del modelo de forma automatica. La relacion se creara
entre las tablas y los nombres de las claves primarias. Se utilizara la siguiente convencion para los nombres.

La clave primaria de la table se llamaré ID + Nombre de la Tabla. Si el nombre de la clave primaria ya existe
en otra tabla se creara una relacion 1:n.

Usa substitucion de Tipos de Datos

Selecciona esta opcion si quieres que cambie algunos nombres de tipos de datos. Esta opcidn puede usarse
para mapear diferentes tipos de datos para diferentes motores de bases de datos.
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Por defecto estara seleccionada la Substitucion de Tipos de Datos [MySQL Standard]. Esta substitucion
reemplazard las abreviaciones [int] y [dec] con los tipos[INTEGER] y [DECIMAL].

Para cambiar el nombre de un tipo de dato selecciona esta opcidn, cambia la Substitucion de Tipos de Datos a
[Definido por Usuario] y afiade una linea a la Lista de Substituciones de Tipos de Datos. Usa el siguiente
formato:

[AntiguoNombreDeTipo=NuevoNombreDeTipo], p.e. [int=INTEGER] reemplazara todos los tipos de datos
[int] por tipos [INTEGER].

Ejecucién de la funcion

Para ejecutar la funcion pulsa [Ejecutar] al final del di&logo.

Crear Inserts Standard desde los datos de la tabla

Esta opcion puede ser usada para crear Inserts Standard de forma automatica en las tablas creadas. Los Inserts
Standard se crearan a partir de los datos guerdados en la base de datos.

Limita el niumero de registro a...
El nimero de Inserts Standard creados puede ser limitado a un nimero maximo usando esta opcion. Esto

puede ser de utilidad si hay demasiadas filas guardadas en una tabla, pero solo unos cuantos registros son
necesarios para realizar pruebas.
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Atajos de Teclado

Navegacion

Informacion
Llamar a la ayuda sensible al contexto.
Mantener el espacio pulsado para activar la funcién de

desplazamiento hasta soltarlo.

Mantener el espacio y Ctrl pulsado activa el zoom + hasta

que se sueltan las teclas.

Mantener el espacio y Alt pulsado activa el zoom - hasta

que se sueltan las teclas. Puedes usar también
Espacio+Ctrl+Alt

Tecla Funcion

F1 Ayuda

Space Desplazamiento
Ctrl + Space Zoom +

Alt + Space Zoom -

Ctrl + Tab Cambiar Modo

Cambiar el Modo de Trabajo de Disefio a Consulta'y

viceversa.

Ctrl + Shift + Tab Cambiar Paletas

Pulsar una vez para ocultar todas las paletas y pulsa de

nuevo para volver a mostrarlas.

Ctrl + Shift + 1..0 Guardar Marcador de Posicién

Pulsar Ctrl + Shift + 1,2, .. 0 para guardar un marcador de

Posicién.

Ctrl +1..0 Cargar Marcador de Posicion Para recuperar un Marcador de Posicion pulsa Ctrl + 1,2, ..
0. Se recuperara la posicion y el factor de zoom que
seguardaron.

Modo de Disefio

Tecla Funcion Informacién

Ctrl+Q Seleccionar Objeto(s) Activar el cursor Puntero. En el Modo Disefio los

objetos también pueden moverse con este cursor.

Ctrl + W Mover Objeto(s) Activar el cursor Mover. Necesario para mover

objetos en modo Consulta.

Ctrl+ E Escalar Objeto Activar el cursor Escalar. Usar solo con objetos

imagen y region.

Ctrl+T New Table Cambiar el cursor del mouse a Modo Nueva Tabla.

Ctrl + Shift+ R New 1:n Relacion

Ctrl+R New 1:n Relacion (no identificadora)

Ctrl + Shift + Alt R New 1:1 Relacion

Cambiar el cursor del mouse a New 1:n Modo
Relacion.

Cambiar el cursor del mouse a New 1:n Modo
Relacién no identificadora.

Cambiar el cursor del mouse a New 1:1 Modo
Relacion.
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Ctrl + A

Ctrl + Del

Ctrl + Shift + C
Ctrl+Z

Ctrl + Shift + Z

Ctrl + O
Ctrl + S

Ctrl + Shift+ S

Seleccionar Todo
Eliminar Seleccionado
Copiar Nombre Realzado
Deshacer Gltima accion

Rehacer ultima accion deshecha

Abrir el Modelo
Guardar el Modelo

Exportar Script SQL

Modo de Consulta

Tecla
F9
Ctrl +Q

Ctrl+S

Ctrl+ F

Ctrl + W

Ctrl + G

Ctrl+H

Ctrl + O

Ctrl + E

Ctrl + Shift + A

Ctrl + Shift+ D

Ctrl + Shift + P

Funcién
Ejecutar comando SQL
Seleccionar Objeto(s)

Afadir Columna a SELECT
Afadir Columna a FROM

Afadir Columna a WHERE

Afadir Columna a GROUP BY

Afadir Columna a HAVING

Afadir Columna a ORDER BY

Afadir Columna a SET

Copiar SQL a Porta Papeles
Copiar SQL a Porta Papeles

Copiar SQL a Porta Papeles

Seleccionar todos los objetos

Eliminar todos los objetos seleccionados.
Copiar el nombre realzado al porta papeles.
Deshacer Gltima accion.

Rehacer ultima accion deshecha.

Abrir un Modelo existente.

Guardar el Modelo actual. También puede
guardarse pulsando sobre el botdn Disquette.

Llama al Didlogo de Cracion de SQL DDL para
exportar el modelo actual.

Informacion
Ejecutar el comando SQL actual.

Activar el cursor Puntero. In Design-Mode objects can
also be moved with this cursor.

Cursor del ratén para afadir Columnas a la parte
SELECT del comando SQL.

Cursor del ratén para afiadir Columnas a la parte FROM
del comando SQL.

Cursor del ratdn para afiadir Columnas a la parte WHERE
del comando SQL.

Cursor del ratén para afiadir Columnas a la parte GROUP
BY del comando SQL.

Cursor del ratén para afiadir Columnas a la parte
HAVING del comando SQL.

Cursor del ratén para afiadir Columnas a la parte ORDER
BY del comando SQL.

Cursor del ratdn para afiadir Columnas a la parte SET del
comando SQL.

Copiar el comando actual SQL al porta papeles,
formateado para ASP.

Copiar el comando actual SQL al porta papeles,
formateado para Delphi/Kylix.

Copiar el comando actual SQL al porta papeles,
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formateado para PHP
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DBDesigner 4 - Historico de Versiones

Lanzamientos de Cddigo

Version
4.055

4.05.4

4.05.3

4.05.2

4.05.1

4.04.9

4.04.8

4.04.7

4.04.6

Cambios

* Correccion: Added option to deactivate quotes around default values.
» Correccion: Added bug when fetching standard inserts from oracle.
« Correccion: Fixed mouse cursor problem.

« Correccion: The last placed table was not printed or displayed on the Navigator when
placed on a region.

* Correccion: A "List index out of bounds" error in the Relationship Editor.

« Correccion: Enlarged Open/Save dialogs for Chinese and Korean Windows.

» Correccion: Installer was missing midas.dll.

« Correccion: Refresh was missing after drag'n'drop of datatype onto a column of a table
on the canvas.

» Novedad: Option to export Linux style linebreaks.

* Novedad: Option to switch off datatype sync between FKs and PKs.

» Novedad: When resizing the table editor the Comment column gets resized, too.

« Correccion: Crow's Foot 1:1 Notation.

« Correccion: Multibyte Language Reading Error.

* Correccion: Region color is restored after discarding changes in the Region Editor.

« Correccion: Improvment of the focus bug in Table Editor.

* Novedad: Popup Menu entries in the Table Editor Column Grid to move columns up and
down.

* Correccion: Improvement of the focus bug in Table Editor.

» Novedad: When using the a relationship tool the right mouse button can be used to
choose a column as the Foreign Fey. This works only when there is only ONE Primary
Key in the source table.

* Novedad: Tables can be reordered in the Model Palette. New functions to sort tables by
name and regions have been added.

» Novedad: Autolncrement is now turned on for Primary Keys by default.

» Correccion: Using the Eraser tool caused AVs. fixed.
* Correccion: Linux: Several libraries are now included with the distribution.
The following libraries have been added:
libpng.so0.2.1.0.12
liblcms.s0.1.0.9
libstdc++.50.5.0.0

» Correccion: Fixes the focus bug in Table Editor. After entering the last columns name the
focus was to set back to the Column Grid. fixed.
« Correccion: The Open/Save Dialogs should work on Win98 again.

» Novedad: The Model Canvas Size can be edited in the Model Options Dialog.
» Novedad: In Query Mode the Result Dataset can be printed to a PDF Document.

» Correccion: When a column name or datatype is edited in the Table Editor and the Editor
is closed before the change is submitted the new value is lost. fixed.
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4.04.5

4.04.4

4.04.3

4.04.2

4.04.1

4.0.3.29

4.0.3.28

4.0.3.27

4.0.3.26

* Correccion: Float values where not synchronised correctly. fixed.

» Novedad: When deleting the selected Objects the names of the Objects are displayed
before deletion.

* Novedad: The Insert Key inserts a column in the Table Editor.

* Novedad: The Splitter position in the Table Editor is now saved.

* Correccion: When placing a model, the error message "Cannot focus a disabled or
invisible window" was displayed. fixed.

* Correccion: Tips were displayed in wrong language some time. Fixed.

« Correccion: Some corrections of wrong assigned language texts.

« Correccion: Setting path was not set so it was not able to change settings. fixed.
« Correccion: Font issues finally addressed. fixed.

* Correccion: Linux: When DBD4 was started the very first time, the directory
~/.DBDesigner4 was not present which caused DBD4 not to start. fixed.
» Correccion: The Page & Printer Setup Dialog could not be displayed. fixed.

* Novedad: Added new version of the SimpleWebFront Plugin 0.6.4.5

* Novedad: Linux: linked against newer libgt.so.2.3.2 which enables smooth fonts on
Linux.

* Novedad: Export of SQL Optimize Tables Script and SQL Repair Tables Script.

» Novedad: Several libraries have been removed from the Linux distribution because they
are no longer needed.

* Correccion: Table comments were not loaded from Model files. fixed.

« Correccion: The Undo command after object(s) have been deleted was doing nothing.
fixed.

» Correccion: Modelfont was not saved. fixed.

» Novedad: Objects can be linked from other Models and can be automatically refreshed.
* Novedad: A new XML Parser is introduced to improve speed.

* Novedad: Info text for Models stored in Databases.

* Novedad: French translation by Alain Ségalou.

* Correccion: Deleting a relation could lead to AV. fixed.

» Correccion: After an update the existing DBConnections were not read and overwritten.
fixed.

» Correccion: Special Characters used in a Datatype's name or Description would cause a
model not to open.

* Correccion: Improved Cursor Key handling. Selected Objects were moved even when an
editor was active.

» Novedad: Cursor Keys move selected Objects. Shift+Ctrl move objects faster.

* Novedad: 1:1 Non-Identifying added.

* Novedad: Crow-Foot Notation.

» Novedad: Region can be selected by click on Object Name.

» Correccion: When a Table was connected to itself by a identifying Relation an unlimited
number of recursive PKs were edit. Now only non-identifying Relations are allowed.

» Novedad: Native MSSQL Reverse Engineering / Connectivity under Windows.

» Novedad: Automatically collapse Tables while Reverse Engineering to save Canvas
space.

» Novedad: Improved Reverse Engineering Dialog.

* Correccion: Oracle Relations missed PK - FK Mapping. fixed.
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4.0.3.25

4.0.3.24

4.0.3.23

4.0.3.22

4.0.3.21

4.0.3.20

4.0.3.19
4.0.3.18

4.0.3.17

» Correccion: When the language information was not set, the default was not set to
english. fixed.

* Correccion: When more than 10 files are opened these files cannot be added to the
Recent Files Menu. fixed.

« Correccion: The distribution did not contain the latest version of SWF. fixed.

» Novedad: Added new version of the SimpleWebFront Plugin 0.6.2.

* Novedad: Close All menu item in the file menu.

» Correccion: Several Bugfixes in the Database Synchronation function.

« Correccion: Options in the Reverse Engineering dialog now disabled when not selected.

« Correccion: Quotation Character was not used when reverse engineering a MySQL
database. fixed.

* Correccion: When storing a model in a database running on Linux, the ' characters were
removed. fixed.

* Correccion: Double-clicking in the DB Model Palette was only working with tables.
fixed.

» Correccion: Reference Definition for InnoDB Tables were not created because of
different syntax. This can now be adjusted in the Options Dialog.

» Novedad: Application Font can be changed.

» Novedad: Tables can be collapsed.

» Novedad: Shortcut for exporting SQL Script (CTRL+SHIFT+S).

» Novedad: When exporting a SQL Script, Regions can be selected.

» Novedad: Message asking the user to save the model after a plugin was called.

* Novedad: New Menu Entry in the Column Popup Menu in the Table Editor to add
column(s) to the current index.

» Novedad: Improved table shadows under Linux.

» Correccion: Drag'n'Drop of columns onto the index column list in the Table Editor may
cause an Index out of Bounds error on some machines. fixed.

* Correccion: When using the DBSync function all columns were modified. fixed.
« Correccion: Improved Datalmporter DBConn handling.

* Correccion: Fixed filelist in the Setup.ini.

 Novedad: Physical Column Mapping to enable a e.g. Datatype named GUID which is
automatically changed to BIGINT when exported/synchronized.

» Novedad: Default Datatype substitution for ODBC Databases in the Reverse Engineering
Dialog.

» Novedad: Option to disable Model-Change state after a SQL Command is executed and a
SQL History Entry is made.

« Correccion: There was not space between tablename and ( in the SQL Create/Insert
command causing SQLErrors when using function names as tablenames. fixed.

« Correccion: Hostname / Hostcaption mixup fixed.

» Correccion: Reverse Engineering an Oracle Database causes an AV when there is more
then one relation in the database. Fixed.

» Novedad: Icon for Geographic Datatypes.

» Novedad: Added Column Prefix / Postfix functions to the Table Column's Popup Menu
in the Table Editor.

» Novedad: When several Table Columns are selected in the Table Editor and a datatype
with no parameters required is dragged onto the Column Grid, the datatype is assigned to
all selected columns.
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4.0.3.16

4.0.3.15

4.03.14

4.0.3.13

4.0.3.12

4.03.11

4.0.3.10

» Correccion: When printing, column icons were painted at the wrong place if Show
Foreign Keys was turned off. fixed.

» Correccion: Using a real n:m relation may lead to AV when automatic index generation
for FK fields is turned on. fixed.

* Correccion: When selecting several Table Columns in the Table Editor and pressing the
right mousebutton, only one Column was selected. fixed.

» Correccion: When removing a Relation, the Foreign Key was not removed from user
defined indices causing AVs when exporting SQL Scripts. fixed.

* Novedad: SQL Syntax Highlighting.

* Novedad: Second SQL Query Layout.

* Novedad: 8 Temporary SQLCommand Drop Targets.

» Correccion: Impropper DateTime values may lead to infinite error message loop.
Improved.

» Correccion: Linux: When closing the program unassigned ActiveControl may lead to
AV. fixed.

» Novedad: Scaling of the Index tab in the Table editor when the whole editor is resized.
» Novedad: Oracle 8 compatibility when reverse engineering a Oracle database.

* Correccion: Recursive relations on a table itself caused various AVs and strange
behaviour. fixed.

* Correccion: When DBDesigner4 was launched the very first time the
DBDesigner4_Translations.txt wasn't copied to the personal files directory. This caused a
warning. fixed.

* Novedad: Translation features were reprogrammed and enabled.
« Correccion: Infinite Loop could cause a Stack Overflow error when two tables were
connected by a relation and were moved to a special position to each other.

» Novedad: Geographic DataTypes added.

» Novedad: When a object is copied to / pasted from the clipboard, the Status Bar displays
a corresponding message.

« Correccion: Deleting a table in the Tables Tab did not remove the table from the list.
That may lead to an AV. fixed

« Correccion: Copying object(s), Saveing the model in the database caused the model's
save path to be changed. fixed.

« Correccion: QApplication_postEvent caused AVs because of improper use. fixed.

» Correccion: When a model was opened from database the stored model was added to the
current model. fixed.

» Novedad: Oracle Reverse Engineering functions.
* Novedad: Recursive Relations to enable a relation between a table and itself.
» Correccion: Translation.ini was bigger than 64kB causing errors when using Win98.

» Novedad: When entering new table columns, the cursor jumps between column name /
datatype automatically.

» Novedad: Copy selected Objects as Image function copies the image to clipboard for use
in Office / Photoshop / ...

* Novedad: Export selected Objects as Image function.

» Novedad: Export Model as Image now only exports the model area, not the complete
model canvas.

» Correccion: When exporting grid-data as SQL INSERTS the tablename could contain the
whole SQL Select command. fixed.
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4.0.3.9 » Correccion: Disabled Translation function because they might cause Access Violations.

4.0.3.8 » Correccion: The default table prefix was added to the tablename, causing broken
DBSync / Export functions. fixed.

4.0.3.7 * Novedad: Schema Filter in the Reverse Engineer Dialog.
» Correccion: When a table prefix was deleted and previously assigned to a table,
exporting SQL Scripts causes an Index out of Bounds error. fixed.

4.0.3.6 * Correccion: When using a Linux MySQL Server one could not list a host's databases or
create a new one. fixed.
« Correccion: Linux: Column Grid in the Table Editor missed Captions. fixed.

4.0.3.5 * Novedad: ESC Key in Editors closes the editor without applying changes.
» Novedad: Table Editor now supports improved Datatype editing.
* Correccion: When a Table is renamed the FK Columns were not updated. fixed.

4.03.4 * Novedad: ERwin 4.1 XML import
* Novedad: Constraint Object move when user holds the Shift Key.
* Novedad: Center Model function in the Edit Main Menu.
» Novedad: New Option to select a different HTML Browser for the HTML
Documentation.
* Novedad: New Option to enable "back ticks" for table/column/index names
» Novedad: New Option to disable reserved words replacement
* Novedad: Localisation
* Correccion: DBSyncronize raised an AV when a table with a very long name was
synchronized. fixed.
« Correccion: DBSyncronize now treats tinyint(1) as BOOL.
» Correccion: FK Datatype and Options were not updated when the source Key was
changed. fixed.
* Correccion: Win98/ME: Open File Dialog raised exception: Drive C: not valid.

4.0.3.3 » Correccion: Compare/Alter Statisic after Database Synchronisation listing was incorrect.
fixed.
« Correccion: Scripts are not executed correctly when using ; as seperator. fixed.

4.0.3.2 » Novedad: New option [Minimize on [Ctrl+Shift+C] Copy Command].

» Novedad: Compare/Alter Statisic after Database Synchronisation.
* Correccion: AV when closing About Window.

4.03.1 » Novedad: When executing a query the affected rows and the execution time is displayed.
* Novedad: SQL Scripts can now be executed.
» Novedad: Reserved words can now be edited in the DBDesigner4 Options dialog.
* Novedad: Automatic Index creation on FK Columns.
* Novedad: Foreign Key Columns are locked in the table editor.
* Novedad: Table Editor can be resized now.
» Novedad: New design of the Table Options / DBDesigner4 Options.
* Novedad (Windows): The DBDesigner4 Settings directory is now located in the user's
Application Data directory. Existing settings are moved from the users Personal Files
directory automatically.
* Novedad: OK / Cancel Buttons in Editors and Option Dialoges.
» Correccion: Exception when syncronizing Standard Inserts and they were not seperated
by a clear line.
» Correccion: When assigning a datatype to a column in the table editor, an additional click
on the datatype palette was required before a datatype could be dragged. fixed. ¢
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4.0.2.96

4.0.2.95

4.0.2.94

4.0.2.93

4.0.2.92

4.0.2.91

4.0.2.90
4.0.2.89
4.0.2.88

4.0.2.87

4.0.2.86

Correccién: When entering several new columns in the table editor, the only way to quit
editing was to press ESC. Now Return in an empty field will chancel the edit mode. ¢
Correccion: Relation Kind was not restored when undo was selected. fixed.

« Correccion: Plugin Parameters where not displayed entirely in the Model Options. fixed.

* Novedad: Ctrl+Shift+Tab now works when Palettes are docked.

* Novedad: Automatic fix of wrong ENUM/SET definition (see 4.0.2.95 release info)

* Correccion: Datatype's parameters could not be editied on Linux machines

* Correccion: Foreign Key Reference no longer contains MATCH FULL/PARTIAL option
« Correccion: ENUM datatype's parameters could be truncated in table editor

» Novedad: Added ForeignKey Prefix / Postfix options.

* Novedad: Added support for ENUM / SET datatypes.

» Correccion: Foreign Key Reference Syntax now works with MySQL 4.0

« Correccion: Foreign Key Reference is now created when using DBSync function.

» Novedad: Added Default Table Type and Default ActivateRefDefForNewRelation
options.

» Novedad: Make DBDesigner4 work with no personal settings for each user with the -
disablePersonalSettings parameter at startup.

» Novedad: Use Table Name In Foreign Key Columns option.
» Novedad: The Default Values for Snap to Grid and TableNamelnRefs can be modified.

« Correccion: When a model was saved after Reverse Engineering an access violation
occured. Fixed.

» Novedad: Snap to Grid feature.
» Correccion: 1Ds of Objects could overlap after model was loaded. Fixed.

» Correccion: Plugin - Data was not loaded. Fixed.

» Novedad: When using the Database Synchronisation function tables are now renamed if
the name was changed in the model. Previously they had beed dropped and recreated.

* Novedad: Index Columns now support the additional lenght parameter for BLOB fields.

« Correccion: Version number was not automatically increased when model was stored in
database and option was selected. Fixed.
» Novedad: The model's version can now be edited in model option dialog.

* First puplic release. Version history will start from this version.

Lanzamientos de Documentacion

Version
1.0.42
1.0.41
1.0.40
1.0.39

1.0.38

Changes

» Renamed syncrosation to synchrosation. Added Plugins Menu
* New Modelling and Quering Section.

 Updated Screenshots and listing of new functions.

* Improved Fundamentals section. Included GNU GPL with the Online and PDF
documentation.

* First puplic release. Version history will start from this version.
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